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TIN HỌC VĂN PHÒNG

PHẦN 3: EXCEL
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NỘI DUNG: MICROSOFT EXCEL

 1. TỔNG QUAN VỀ MS.EXCEL

 2. BẢNG BIỂU TRONG EXCEL

 3. HÀM THÔNG DỤNG TRONG EXCEL
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BÀI 1

GIỚI THIỆU VỀ MICROSOFT EXCEL

4

I. Giới thiệu

 Microsoft Excel là phần mềm chuyên dùng cho 

công tác kế toán, văn phòng 

 Đặc điểm:

+ Thực hiện được nhiều phép tính từ đơn giản 

đến phức tạp.

+ Tổ chức và lưu trữ thông tin dưới dạng bảng  

như: tính lương, thống kê …

+ Khi có thay đổi dữ lịêu, bảng tính sẽ tự động 

tính toán lại theo số liệu mới.
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II. Khởi động MS.EXCEL 

 Cách 1: Nhấp chuột vào Start→Programs 

→Microsoft Excel

 Cách 2: Nhấp chuột vào biểu tượng    

Excel trên thanh Micosoft Office Shortcut 

Bar (Trên góc trên bên phải màn hình )

 Hay Double Click chuột vào biểu tượng 

trên màn hình desktop
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II. Thoát khỏi Microsoft Excel

 Cách 1: Nhấp chuột vào nút        (close) ở 

góc trên bên phải

 Cách 2: Nhấp Menu File → Exit

 Cách 3: Control box → Close

 Cách 4: Nhấn tổ hợp phím Alt + F4
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III. Màn hình làm việc của MS. Excel
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 1) Thanh tiêu đề (Title): Khi khởi động có sẵn là 

Microsoft Excel Book1. Khi ta lưu tài liệu thành 

một tập tin thì thanh này sẽ mang tên tập tin .

 2) Thanh thực đơn (Menu): Cho phép truy cập 

toàn bộ các lệnh và các thiết lập trong Excel .

 3) Thanh tiêu chuẩn (Standard): Cung cấp các 

lệnh và các thủ tục thường dùng nhất.

 4) Thanh định dạng (Formatting): Cho phép định 

dạng nhanh một số thao tác nào đó.

III. Màn hình làm việc của MS. Excel
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 5) Thanh công thức (Formula): Hiển thị địa chỉ và 

dữ liệu hoặc công thức của một ô kích hoạt nào đó.

 6)  Ký hiệu cột (Columns): A B C D …

 7)  Ký hiệu dòng (Rows): 1 2 3 4 …

 8) Thanh cuộc dọc (Horizontal Scroll bar): cho 

phép cuộn lên phía trên hay xuống phía dưới màn 

hình .

 9) Thanh cuộc ngang (Vertical Scroll bar): cho 

phép cuộn qua trái hay qua phải màn hình.

III. Màn hình làm việc của MS. Excel
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 10) Thanh trạng thái (Status): Cho phép 

hiển thị một số trạng thái đặc biệt.

 11) Ô kích hoạt (Active cell): là ô giao giữa 

dòng và cột . Ở góc dưới bên phải của ô kích 

hoạt gọi là Auto Fillhandle .

 12) Vùng các bảng tính (Sheet): quản lýcác 

bảng tính trong tập tin.

III. Màn hình làm việc của MS. Excel
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 1. Khái Niệm

Work book là vùng làm việc của Excel được 

thiết kế để có thể chứa một hoặc nhiều tập 

hợp các bảng tính (sheet), có tối đa là 255

sheet trong 1 work book

IV. Tập tin (WORK BOOK) 
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 2. Các thao tác cơ bản trên tập tin:

+ Mở work book đã có sẵn trên đĩa: File/Open

+ Mở mới work book : File/New 

+ Lưu trữ work book : File/Save

+ Đóng work book : File/Close

(Các thao tác trên thực hiện giống như trong 

Microsoft Word)

IV. Tập tin (WORK BOOK) 
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 1. Khái niệm: 

Sheet là đối tượng làm việc trực tiếp và luôn 

luôn thuộc 1 work book nào đó . Bảng tính là 

tập hợp các dòng và cột 

+ Cột: có tối đa là 256 cột và được đánh thứ 

thự là A,B,C,…

+ Dòng: có tối đa là 65.536 dòng và được 

đánh thứ thự là 1,2,3,…

V. Bảng tính (SHEET) 
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2 . Các thao tác trên bảng tính (sheet)

 a) Chọn sheet: ta nhấp chuột vào sheet cần 

chọn. Ta có thể nhấp chuột trên các nút        

để di chuyển qua lại giữa các sheet . 

 b) Đổi tên sheet: 

- Nhấp chuột phải vào sheet → chọn Rename

- Nhập tên mới → Enter

V. Bảng tính (SHEET) 
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2 . Các thao tác trên bảng tính (sheet)

 c) Chèn thêm sheet mới: 

Nhấp chuột phải vào sheet → chọn Insert →

chọn Worksheet → OK .

lúc đó sheet mới

sẽ nằm bên trái 

sheet được chọn. 

V. Bảng tính (SHEET) 
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2 . Các thao tác trên bảng tính (sheet)

 d) Xoá sheet :

Nhấp chuột phải vào sheet → chọn  “Delete”

→ OK

 e) Di chuyển sheet: 

Ấn giữ chuột kéo sheet đi đến vị trí mong muốn

V. Bảng tính (SHEET) 
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1. Khái niệm

 Địa chỉ là giao của dòng và cột (cột ghi trước và 

dòng ghi sau. VD: B4 nghĩa là giao của cột B và 

dòng thứ 4

 Địa chỉ ô: là địa chỉ của 1 ô. VD: B4 địa chỉ ô B4 

 Địa chỉ khối ô: chỉ địa chỉ của một khối các ô liên 

tiếp nhau. VD: B4 : B14 chỉ một khối các ô từ ô 

B4 đến ô B14 

VI. Địa chỉ 
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2. Các kiểu địa chỉ

 a) Địa chỉ tương đối 

* Cú pháp: <Cột><Dòng> ; VD: A3 , B4

- Tính chất: thay đổi tương đối trong sao chép 

công thức

 b) Địa chỉ cố định

* Cú pháp: <$Cột><$Dòng> ;VD: $A$3,$B$4

-Tính chất: cố định trong sao chép công thức

VI. Địa chỉ 
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2. Các kiểu địa chỉ

 c) Địa chỉ hỗn hợp: là hỗn hợp địa chỉ tương 

đối và địa chỉ cố định

* Cú pháp: <$Cột><Dòng> , <Cột><$Dòng>

VD: $A3 , B$4

VI. Địa chỉ 
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2. Các kiểu địa chỉ

 Chú ý:

- Nguyên tắc sao chép công thức: sao chép từ 

trên xuống thì tăng địa chỉ dòng lên 1 đơn vị, 

cột giữ nguyên; sao chép từ trái qua phải thì 

tăng cột lên 1 đơn vị, dòng giữ nguyên.

- Ta dùng phím F4 để chuyển đổi qua lại giữa 

các kiểu địa chỉ.

VI. Địa chỉ 
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 Enter: Chuyển xuống một ô bảng tính

 Shift+Enter: Chuyển lên một ô bảng tính

 Tab: Chuyển sang phải một ô bảng tín

 Shift+Tab: Chuyển sang trái một ô bảng tính

 Home: Chuyển tới cột A của dòng hiện tại

 Page Up: Chuyển lên một trang màn hình

 Page Down: Chuyển xuống một trang màn 

hình

VII. Di chuyển trên bảng tính 
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 Alt+Page Up:Chuyển sang trái một trang 

màn hình

 Alt+Page Down: Chuyển sang phải một 

trang màn hình

 Ctrl+Home: Chuyển tới ô bảng tính có địa 

chỉ A1

 Ctrl+End: Chuyển tới ô bảng tính có địa chỉ 

tại dòng và cột cuối cùng

VII. Di chuyển trên bảng tính 
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1. Kiểu Văn Bản (Text) 

 Khi nhập văn bản vào phải bắt đầu bằng các 

ký tự từ A → Z. Dữ liệu trong 1 ô dài tối đa 

không quá 255 ký tự . 

 Khi nhập Excel sẽ canh trái, nếu ô kế bên 

không có dữ liệu thì khi nhập văn bản sẽ tràn 

qua kế đó, còn nếu các ô kế có dữ liệu thì 

việc hiển thị sẽ bị che khuất đi 1 phần .

VIII. Các kiểu dữ liệu 
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2. Kiểu Số (Number)

 Khi nhập vào phải bắt đầu bằng các số từ  0 

→ 9. Khi nhập Excel sẽ canh bên phải.

 Chú ý: Trong Excel thông thường ta dùng 

dấu “.” là dấu phân cách giữa phần nguyên 

và phần thập phân . Tuy nhiên ta có thể thay 

đổi lại hệ thống dấu này bằng cách thay đổi 

trong Control Pannel.

VIII. Các kiểu dữ liệu 
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2. Kiểu Số (Number)

 Chú ý:

Để nhập số ở dạng chuỗi ta nhập dấu nháy 

đơn  „ trước, sau đó mới nhập số

Vd: „1234: kết quả chuỗi số 1234

VIII. Các kiểu dữ liệu 
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3. Kiểu Ngày Giờ (Date)

 Khi nhập dữ liệu kiểu ngày giờ phải phụ 

thuộc vào sự qui định của Control Panel. Ta 

dùng dấu “/” để phân cách ngày tháng năm.

 Ví dụ : 

VIII. Các kiểu dữ liệu 
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3. Kiểu Ngày Giờ (Date)

 Chú ý: Để định dạng kiểu ngày, giờ theo 

dạng Việt Nam DD/MM/YYYY thì vào 

Control Panel để định dạng lại như sau :

 Nhấp chuột vào Start/Settings/Control 

Panel →chọn Regional and Language → 

Customize → chọn thẻ Date trong khung 

“Short date format” nhập vào: 

DD/MM/YYYY , chọn “Apply” → “OK”

VIII. Các kiểu dữ liệu 
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1. Cách nhập công thức

 Ta nhập dấu “=” sau đó là công thức. 

 Dữ liệu kiểu chuỗi khi đưa vào công thức 

phải được bao bởi cặp dấu ngoặc kép “ ”

 Ví dụ: =(A2+B2)*10

IX. Công thức 
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2. Các Toán Tử

 a) Các phép toán số học: + , - , * , / ,  ^ (luỹ 

thừa) 

- Độ ưu tiên: ^, *,/,+,- , tuy nhiên có thể sử 

dụng dấu ( ) để thay đổi trật tự ưu tiên của 

các phép toán (các phép toán trong dấu ( ) sẽ 

được thực hiện trước). 

 Vd : =3^2 → 9 ; =A5*7

IX. Công thức 
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2. Các Toán Tử

 b) Các phép toán so sánh :

> , >= , < , <= , =, <>(khác)

Vd: a<>b  ( a khác b)

 c) Toán tử ghép chuỗi : “&” 

Vd: “Nguyễn Văn” & “A” → “Nguyễn Văn 

A”

IX. Công thức 
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3. Sao chép công thức 

 Sao chép công thức là trỏ chuột tại Auto 

Fillhandle của ô chứa công thức (khi trỏ 

chuột xuất hiện dấu “+” ) nhấn và kéo

xuống hay qua phải  cho những ô cần chép 

công thức .

IX. Công thức 

32

BÀI 2

BẢNG BIỂU TRONG EXCEL
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1. Chọn ô hoặc khối ô: 

 Chọn ô ta nhấp chuột tại ô muốn chọn 

 Chọn nhiều ô ta nhấp chuột tại ô đầu tiên sau đó 
quét chuột đến ô cuối cùng.

2. Chọn một hoặc nhiều cột:

 Chọn  một cột: ta nhấp chuột vào ký hiệu cột: 
A,B,C….

 Chọn nhiều cột liên tiếp: nhấp chuột tại ký hiệu 
cột đầu tiên sau đó quét chuột đến ký hiệu cột cuối 
cùng.

I. Các thao tác trên ô bảng tính (CELL) 

34

3. Chọn một hoặc nhiều dòng: 

 Chọn  một dòng ta nhấp chuột vào ký hiệu dòng: 
1,2,3….

 Chọn nhiều dòng liên tiếp: ta nhấp chuột tại ký 
hiệu dòng đầu tiên sau đó quét chuột đến ký hiệu 
dòng cuối cùng 

4. Chọn toàn bộ bảng tính :

 Cách 1 : Nhấp tổ hợp phím Ctrl+A .

 Cách 2 : Nhấp chuột vào ô giao của thanh ký 
hiệu cột và thanh ký hiệu dòng 

I. Các thao tác trên ô bảng tính (CELL) 



18

35

1. Di chuyển dữ liệu (cut – paste): 

 Cách 1: Chọn ô hoặc khối ô cần di chuyển →

trỏ chuột lên khối ô ấn giữ chuột kéo đi.

 Cách 2: Chọn ô hoặc khối ô cần di chuyển, 

vào Edit → Cut sau đó nhấn Edit → Paste

 Cách 3: Click chuột phải chọn Cut hay nhấn 

tổ hợp phím Ctrl+X sau đó nhấn Ctrl+V

II. Các thao tác cơ bản về khối 
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2. Sao chép dữ liệu (copy – paste): 

 Cách 1: Chọn ô hoặc khối ô cần copy → Ấn 
giữ Ctrl đồng thời kéo ô hoặc khối ô đi.

 Cách 2: Chọn ô hoặc khối ô cần copy, vào 
Edit → Copy sau đó nhấn Edit → Paste

 Cách 3: Click chuột phải chọn Copy hay
nhấn tổ hợp phím Ctrl+C sau đó nhấn 
Ctrl+V

II. Các thao tác cơ bản về khối 
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3. Sửa đổi dữ liệu: 

 Nhấp đúp chuột tại vị trí muốn sửa đổi hoặc
nhấp chuột tại vị trí muốn sửa đổi trên thanh 
công thức hoặc nhấn phím F2 vào ô cần sửa 
đổi sau đó thực hiện việc sửa đổi.

4. Phục hồi dữ liệu trước đó (Undo)

 Nhấp chuột vào biểu tượng        hoặc nhấn tổ 
hợp phím “Ctrl+z”

II. Các thao tác cơ bản về khối 
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5. Phục hồi dữ liệu sau đó (Redo)

 Khi bạn đã phục hồi lại dữ liệu đến khi nào đó 
bạn lại quyết định không phục hồi lại dữ liệu 
thì ta thực hiện lệnh “Redo” bằng cách nhấp 
chuột vào biểu tượng 

6. Đặt tên cho khối 

 Quét khối nội dung cần đặt tên →Vào 
Insert/Name/Define → Khung Name in 
workbook: nhập tên cho khối → “OK”

II. Các thao tác cơ bản về khối 
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1. Thay đổi chiều rộng của cột và hàng

 a) Thay đổi chiều rộng của cột 

Trỏ chuột vào viền bên phải của ký hiệu cột khi đó 

con trỏ chuột biến thành hình mũi tên 2 chiều ta thực 

hiện 1 trong các cách sau đây:

+ Kéo về bên trái: để giảm chiều rộng cột 

+ Kéo về bên phải: để nới chiều rộng cột 

 b) Thay đổi chiều rộng của dòng : tương tự cột

III. Các thao tác về hàng và cột 
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2. Chèn thêm một dòng mới

 Cách 1: Nhấp phải chuột lên ký hiệu dòng chọn 
Insert. Lúc đó dòng mới chèn vào sẽ nằm bên trên 
dòng được chọn.

 Cách 2: vào Insert chọn  Rows

3. Chèn thêm một cột mới

 Cách 1: Nhấp phải chuột lên ký hiệu cột chọn 
Insert lúc đó cột mới chèn vào sẽ nằm bên trên cột 
được chọn.

 Cách 2: vào Insert chọn  Columns

III. Các thao tác về hàng và cột 
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4. Xóa dòng hoặc cột

 Cách 1: Chọn dòng (cột) muốn xoá. Ấn 

phím Delete

 Cách 2: Nhấp phải chuột lên ký hiệu dòng 

(cột) muốn xóa → chọn Delete.

III. Các thao tác về hàng và cột 
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1. Sử dụng thanh công cụ (tương tự word)

2 . Sử dụng thanh Menu 

- Nhấp chuột vào menu Format/Cells khung 

hộp thoại xuất hiện 

- Chọn thẻ “Font” 

(Thực hiện định dạng giống như trong Word)

IV. Định dạng ký tự

(Font, size, Bold, Italic, Underline, font color)
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- Chọn ô hoặc khối ô cần định dạng 

1. Dùng biểu tượng: dùng các biểu tượng trên 

thanh công cụ

2. Sử dụng thanh Menu:

 Vào Format /cells: khi đó xuất hiện hộp 

thoại → Chọn thẻ Alignment

V. Canh lề dữ liệu

44

2. Sử dụng thanh Menu: gồm các thuộc tính

 Trong khung “Horizontal”: canh lề theo 
chiều ngang.

• General : định dạng mặc nhiên của dữ liệu

• Left : canh dữ liệu về bên trái

• Center : canh dữ liệu vào giữa

• Right : canh dữ liệu về bên phải

• Justify : canh dữ liệu đều ở 2 bên .

V. Canh lề dữ liệu
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2. Sử dụng thanh Menu: gồm các thuộc tính

 Trong khung “Vertical” : canh lề theo chiều 

dọc 

• Top : canh dữ liệu ở phía trên

• Center : canh dữ liệu vào giữa

• Justify : canh dữ liệu đều ở 2 bên .

 Trong khung “Orientation” : Xoay dữ liệu 

theo 1 góc tuỳ chọn  

V. Canh lề dữ liệu
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2. Sử dụng thanh Menu: gồm các thuộc tính

 Trong khung Text Control : đánh dấu chọn vào 
các ô sau :

• Wrap text : bật/tắt chế độ tự động xuống dòng 
khi nháy trỏ chạm lề phải của ô

• Shrink to fit : bật/tắt chế độ co giản các chữ để 
vừa khít trong ô

• Merge cells : bật/tắt chế độ trộn các ô để trở 
thành 1 ô duy nhất

 Nhấp “OK” .

V. Canh lề dữ liệu
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3. Trộn nhiều ô thành 1 ô

 Chọn khối ô cần trộn

 Nhấp chuột vào biểu tượng        (Merge And 

Center) 

 Chú ý : để bỏ trộn ta Vào Format/Cells →

Chọn thẻ Alignment → ta nhấp bỏ  dấu chọn 

ở ô “Merge cell” → “OK”  hoặc nhấp chọn 

biểu tượng (Merge And Center) lần nữa.

V. Canh lề dữ liệu
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Chọn ô hoặc khối ô cần thực hiện 

 Cách 1: Sử dụng biểu tượng 

- Nhấp chuột vào mũi tên của biểu tượng   

(Borders). Khi đó xuất hiện khung chứa các 

dạng kẻ đường viền. Cho phép chọn 1 kiểu 

đường viền cần tạo .

VI. Kẻ đường viền
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 Cách 2: Sử dụng thanh Menu

- Vào Format/cells →khi đó xuất hiện hộp thoại 

→ Chọn thẻ Border

VI. Kẻ đường viền
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+ Khung Style : chọn các kiểu của đường viền .

+ Khung Color : chọn màu đường viền 

+ Trong khung Presets : chọn 1 trong các chức năng 

• None : không có đường viền

• Outline : các đường viền bên ngoài 

• Inside : các đường viền bên trong 

+ Trong khung “Border” : chọn riêng từng đường 

(trên, dưới , trái , giữa, phải …)

+ Nhấn “OK” .

VI. Kẻ đường viền
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Chọn ô hoặc khối ô cần tạo nền và màu 

sắc trang trí 

 Cách 1: Sử dụng biểu tượng 

Nhấp chuột vào biểu tượng         (Fill color)

 2 . Sử dụng thanh Menu

- Vào Format/Cells → xuất hiện hộp thoại

→ Chọn thẻ Patterns

VII. Tạo nền và màu sắc trang trí

52

VII. Tạo nền và màu sắc trang trí

+ Khung color: chọn màu 

sắc thích hợp (No color 

không màu)

+ Khung Pattern: dùng 

để chọn mẫu tô 

+ Khung Sample: hiện 

thị màu và mẫu tô đã 

được chọn 

+ Nhấp “OK” 
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Chọn ô hoặc khối ô cần định dạng 

- Nhấp chuột vào Format/Cells → Chọn “Number”

- Khung “Decimal places” ta khai báo số chỉ số sau 

dấu thập phân

- Khung Category (khung bên trái): chọn các kiểu 

dữ liệu cần định dạng

- Khung Sample (khung bên phải): hiển thị dạng số 

được chọn. 

VIII. Định dạng dữ liệu trong ô (cell)

54

a ) Kiểu số (Number)

- Khung “Category”:  ta chọn “Number”

- Khung “Decimal places” ta khai báo số chỉ 
số sau dấu thập phân

- Nếu ta đánh dấu chọn vào ô “Use 1000 
Separator (,) ” thì sẽ có dấu phân cách hàng 
ngàn

- Trong khung “Negative numbers” ta chọn 
dạng thể hiện của số âm .

VIII. Định dạng dữ liệu trong ô (cell)
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b ) Currency (tiền tệ)

- Khung “Category”:  ta chọn “Currency”

- Khung “ Decimal places” : thì sẽ có dấu 

phân cách hàng ngàn

- Khung “Symbol” : ta chọn ký hiệu tiền tệ 

cần thể hiện

- Trong khung “Negative numbers” ta chọn 

dạng thể hiện của số âm

VIII. Định dạng dữ liệu trong ô (cell)

56

c) Kiểu Date

- Khung “Category”:  ta chọn “Date”

- Khung “Type” ta chọn dạng ngày tháng cần 
thể hiện vào ô được chọn .

d ) Kiểu Time (giờ)

Tương tự như kiểu Date

f )   Kiểu Percentage (%)

Tương tự như kiểu số

VIII. Định dạng dữ liệu trong ô (cell)
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g)  Kiểu Custom : 

Kiểu do người sử dụng định nghĩa 

- Khung “Category” ta chọn “Custom”

VIII. Định dạng dữ liệu trong ô (cell)

58

IX. Thực hành

 Nhập liệu như nội dung bảng bên dưới.

 Thực hiện các thao tác trộn ô, canh lề các cột, định dạng các 

cột ngày theo kiểu dd/mm/yyyy.
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IX. Thực hành

 Nhập liệu như nội dung bảng bên dưới.
 Thực hiện các thao tác trộn ô, kẻ đường viền, định 
dạng các ô theo mẫu bên dưới.

60

BÀI 3

HÀM TRONG EXCEL
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1. Giới thiệu

 Hàm là một đoạn chương trình có sẳn thực 

hiện một yêu cầu nào đó.

I. Khái niệm

62

2. Cách nhập hàm

 Cú pháp: = Tên Hàm (đối số 1, đối số 2, …, 

đối số n)

+ Tên Hàm: sử dụng theo quy ước của Excel

+ Đối số: là các trị số, chuổi, địa chỉ ô, vùng, 

công thức hoặc một hàm nào khác|

Vd : =SUM(A1,A3,A5) 

=SUM(D3:D13)

I. Khái niệm
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Chú ý:

 Cú pháp của hàm không phân biệt chữ hoa 

với chữ thường

 Hàm có thể chứa tối đa 30 đối số nhưng 

không được quá 255 ký tự

 Đối số là địa chỉ ô thì sẽ bị thay đổi khi thực 

hiện sao chép công thức

 Hàm không chứa các khoảng trắng

I. Khái niệm

64

3. Sử dụng chức năng Function Wizard trên 
thanh công cụ

 B1: Di chuyển ô hiện hành đến ô cần nhập 
hàm

 B2: Nhấp chuột vào menu Insert Function
hoặc Shift+F3 hoặc nhấp chuột vào biểu 
tượng                      trên thanh công cụ 

 xuất hiện hộp thoại:

I. Khái niệm
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3. Sử dụng chức năng Function Wizard trên 

thanh công cụ

*B3:

I. Khái niệm

Chọn 
nhóm hàm 

sử dụng
Chọn hàm 

cần sử dụng

Đồng ý

66

3. Sử dụng chức năng Function Wizard trên 

thanh công cụ

 B4: Xuất hiện cửa số mới, thực hiện chọn các 

đối số (bằng cách quét khối vào các ô chứa 

đối số) hoặc nhập vào

 B5: Nhấn “OK” để hoàn thành 

I. Khái niệm
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1. Nhóm hàm số học (Math & Trig)

 Hàm ROUND: dùng để làm tròn một giá trị 

số đến số các chữ số đã được chỉ định rõ (số 

n) kể từ dấu thập phân 

Cú Pháp : =ROUND(số, n)

+ số: số cần làm tròn 

+ n: số chỉ số làm tròn

II. Các hàm thông dụng

68

 Hàm ROUND:

+ n > 0 : làm tròn số về bên phải đến n chỉ số tính từ 
cột hàng đơn vị 

Vd : =ROUND(5.7263,2)  5.73

Vd : =ROUND(5.7133,2)  5.71

+ n < 0 : làm tròn số về bên trái đến n chỉ số tính từ 
cột hàng đơn vị

Vd : =ROUND(3207.12,-2)  3200

Vd : =ROUND(31264.3,-2)  31300

+ n=0 : làm tròn số đến cột hàng đơn vị

Vd : =ROUND(3207.12,0)  3207

II. Các hàm thông dụng
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Ví dụ (ROUND)

 Tính ĐTB = (Toán x3 + Lý x2 + Hoá)/6 và dùng 
Round làm tròn lấy 2 số lẽ 

=ROUND((C2*3+D2*2+E2)/6,2)  8.08

II. Các hàm thông dụng
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II. Các hàm thông dụng

Bài tập:

Cho dữ liệu như bảng sau:
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II. Các hàm thông dụng

Mô tả:

- Tiền USD hàng mua = Số lượng * Đơn giá USD 

hàng mua. Làm tròn và lấy 1 số lẻ. 

- Tiền VND hàng mua = Tiền USD hàng mua * Tỉ 

giá VND (Tỉ giá VND là 16200).

- Tiền VND hàng bán = Số lượng * Đơn giá VND 

hàng bán. 

- Làm tròn số hàng ngàn cho Tiền VND hàng mua 

và Tiền VND hàng bán. 

72

2. Nhóm hàm xử lý chuỗi (Text)

 5.1. Hàm LEFT:

Cú Pháp : =LEFT(chuỗi,n)

Ý nghĩa : dùng để trích n ký tự bên trái của 

chuỗi 

Vd : =LEFT(“TTDVVLBL”,6) TTDVVL

=LEFT(A2,2)

II. Các hàm thông dụng
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2. Nhóm hàm xử lý chuỗi (Text)

 5.2. Hàm RIGHT:

Cú Pháp : =RIGHT(chuỗi,n)

Ý nghĩa : dùng để trích n ký tự bên phải của 

chuỗi 

Vd : =RIGHT(“TTDVVLBL”,2) BL

=RIGHT(A2,2)

II. Các hàm thông dụng
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2. Nhóm hàm xử lý chuỗi (Text)

 5.3. Hàm MID:

Cú Pháp : =MID(chuỗi,m,n)

Ý nghĩa : dùng để trích n ký tự  ở giữa của 

chuỗi tại vị trí thứ m tính từ bên trái sang.

Vd: =MID(“TTDVVLBL”,3,4) “DVVL”

=MID(A2,3,1)

II. Các hàm thông dụng
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II. Các hàm thông dụng

 Thực hành các hàm xử lý chuỗi:

- Nhập dữ liệu như bảng sau:

76

II. Các hàm thông dụng

Mô tả:

- Mã hàng: là hai ký tự đầu của Lô hàng

- Mã NSX: là 2 ký tự thứ 5 và 6 của Lô hàng

- Đơn giá (USD): là 3 ký tự thứ 7, 8,9 của Lô 

hàng

- Số lượng: là 3 ký tự cuối của Lô hàng

- Thành tiền = Số lượng * Đơn giá (USD) * 

19000
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3. Nhóm hàm thời gian (Date & Time )

 3.1. Hàm DAY: trả về giá trị là ngày của 
chuỗi ngày/tháng/năm

Cú Pháp : = DAY(ngày/tháng/năm)

Vd : =DAY(A1)  7

II. Các hàm thông dụng

78

3. Nhóm hàm thời gian (Date & Time )

 3.2. Hàm MONTH: trả về giá trị là tháng của 

chuỗi ngày/tháng/năm

Cú Pháp : = MONTH(ngày/tháng/năm)

II. Các hàm thông dụng

 3.3. Hàm YEAR: trả về giá trị là năm của 

chuỗi ngày/tháng/năm

Cú Pháp : =YEAR(ngày/tháng/năm) 
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II. Các hàm thông dụng

 Thực hành:
Cho bảng dữ liệu như sau:

80

Mô tả:

- Ngày hết hạn = Ngày nhập + Số ngày lưu kho

- Số ngày vượt = Ngày xuất - Ngày hết hạn

- Số tiền thuê kho = (Số ngày lưu kho * 

100000) + (Số ngày vượt * 150000)

II. Các hàm thông dụng



41

81

3. Nhóm hàm thời gian (Date & Time )

 3.4. Hàm HOUR: trả về giá trị là giờ của 

chuỗi giờ:phút:giây 

Cú Pháp : = HOUR(giờ:phút:giây)

II. Các hàm thông dụng

 3.5. Hàm MINUTE: trả về giá trị là phút của 

chuỗi giờ:phút:giây

Cú Pháp : =MINUTE(giờ:phút:giây) 

82

3. Nhóm hàm thời gian (Date & Time )

 3.6. Hàm SECOND: trả về giá trị là giây của 

chuỗi giờ:phút:giây 

Cú Pháp : =SECOND(giờ:phút:giây)

II. Các hàm thông dụng
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II. Các hàm thông dụng

 Thực hành:

Nhập vào bảng dữ liệu sau:

84

Mô tả:

- Tính số giờ sử dụng máy= Giờ bắt đầu - Giờ 

kết thúc. Lấy số giờ.

- Tính số phút sử dụng máy= Giờ bắt đầu - Giờ 

kết thúc. Lấy số phút.

- Số tiền = (Số giờ * 2800) + (Số phút * 50)

II. Các hàm thông dụng
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4. Nhóm hàm Logic (Logical)

 Hàm IF: IF(biểu thức điều kiện, biểu thức đúng, 
biểu thức sai)

Ý nghĩa :Hàm này đầu tiên kiểm tra biểu thức điều kiện, 
nếu biểu thức điều kiện đúng sẽ nhận kết quả là biểu 
thức đúng, ngược lại (biểu thức điều kiện sai) sẽ nhận 
kết quả là biểu thức sai.

Vd: IF(a>=20, a-20,a+20)

Trường hợp :

a=10  kết quả= 30

a=30  kết quả=10

II. Các hàm thông dụng
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4. Nhóm hàm Logic (Logical)

 Hàm IF:

Chú ý: 

- Nếu có n điều kiện thì ta sử dụng n-1 hàm IF

- Trong công thức nếu có sử dụng chuỗi thì chuỗi 

này phải được đặt trong dấu nháy kép  “”. 

- Nếu có nhiều điều kiện (3 trở lên) thì ta sử dụng 

các IF lồng nhau.

- Tên hàm không phân biệt chữ hoa và chữ thường.

II. Các hàm thông dụng
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4. Nhóm hàm Logic (Logical)

 Hàm IF:

VD: Xếp loại cho học sinh như sau :

Nếu ĐTB>=8.5 thì Giỏi   ;   Nếu ĐTB>=7.0 thì Khá

Nếu ĐTB>=5.0 thì TB     ;   Nếu ĐTB<5.0 thì Yếu

=IF(ĐTB>=8.5,“Giỏi”,IF(ĐTB>=7.0,“Khá”,IF(ĐTB>

=5.0,“Trung bình”, “yếu”)))

* Giả sử: ĐTB có địa chỉ ô là H3. Công thức được viết   

=IF(H3>=8.5,“Giỏi”,IF(H3>=7.0,“Khá”,IF(H3>=5.0, 

“Trung bình”, “yếu”)))

II. Các hàm thông dụng
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II. Các hàm thông dụng

 Thực hành bài 1:
Nhập dữ liệu theo bảng sau:
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II. Các hàm thông dụng

Mô tả:

- Phụ cấp: 300000 đồng nếu số con >=2, ngược lại là

100000 đồng

- Hệ số chức vụ: 2 nếu chức vụ là “TP”, 1 nếu chức vụ là

“PP”, còn lại là 0.

- Tiền khen thưởng: 500000 đồng nếu loại khen thưởng là

“A”, 300000 đồng nếu loại khen thưởng là “B”. Ngược lại

bằng 0.

- Tiền lương = (Mức lương cơ bản * Hệ số lương) + Phụ

cấp + (Mức lương cơ bản * Hệ số chức vụ) + Tiền khen

thưởng.
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 Thực hành bài 2:
Nhập dữ liệu theo bảng sau:

II. Các hàm thông dụng
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II. Các hàm thông dụng

Mô tả:

- Điểm TB = (Điểm HK2 * 2 + Điểm HK1)/3

- Thi lại là “X” nếu điểm TB<=4.

- Xếp loại: “Giỏi” nếu 9 <= điểm TB <= 10

“Khá” nếu 7 <= điểm TB < 9

“TB” nếu 4 < điểm TB < 7

“Yếu” nếu điểm TB <= 4

- Loại khen thưởng: “A” nếu điểm TB >8 và là “B” nếu 

điểm TB từ 7 đến 8.

- Học sinh xuất sắc là “X” nếu điểm TB>=9.5 và điểm HK1 

và HK2 từ 9 trở lên.

92

5. Nhóm hàm thống kê (Statistical)

 5.1. Hàm SUM: trả về giá trị tổng của các đối 

số

Cú Pháp : =SUM(đối số 1,đối số 2,…,đối số n)

Vd : =SUM(2,5,10,14) 31

II. Các hàm thông dụng
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5. Nhóm hàm thống kê (Statistical)

 5.2. Hàm AVERAGE: trả về giá trị trung 

bình cộng của các đối số

Cú Pháp : =AVERAGE(đối số 1,đối số 

2,…,đối số n)

Vd : =AVERAGE(4,8,9)  7

Vd : =AVERAGE(E3:E8)  61.58

II. Các hàm thông dụng
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5. Nhóm hàm thống kê (Statistical)

 5.3. Hàm MAX: trả về giá trị lớn nhất của các 
đối số

Cú Pháp : =MAX(đối số 1,đối số 2,…,đối số n)

Vd : =MAX(4,8,20,15)  20

=MAX(E3:E8)  150.00 

* Tương tự ta có hàm MIN trả về giá trị nhỏ nhất
của các đối số

II. Các hàm thông dụng
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II. Các hàm thông dụng

Thực hành

Nhập vào bảng dữ liệu sau:
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II. Các hàm thông dụng

Thực hiện:

- Tính tổng cộng số lượng xuất cho mỗi vật tư.

- Tính tổng cộng số lượng xuất cho mỗi vật tư 

theo từng tháng.
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6. Nhóm hàm dò tìm (Lookup & Reference)

 6.1. Hàm VLOOKUP (dò tìm theo chiều dọc)

Cú Pháp : =VLOOKUP(giá trị dò tìm, bảng 

dò tìm, cột tham chiếu, cách dò)

+ Giá trị dò tìm : là giá trị 1 ô kiểu số hoặc kiểu 

chuỗi trên bảng chính có liên quan đến bảng 

phụ (bảng dò tìm)

II. Các hàm thông dụng
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 6.1. Hàm VLOOKUP (dò tìm theo chiều dọc)

+ Bảng dò tìm (bảng phụ) : là địa chỉ của 1 khối 

dữ liệu  (khối này thường phải dùng địa chỉ cố 

định bằng cách sử dụng phím F4)

+ Cột tham chiếu : số thứ tự cột cần lấy trong 

bảng phụ tính từ bên trái sang. 

+ Cách dò : chỉ mang một trong hai giá trị là 0

(tìm chính xác) hay 1 (tìm tương đối)

II. Các hàm thông dụng
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 6.1. Hàm VLOOKUP (dò tìm theo chiều dọc)

+ Ý nghĩa : Hàm này lấy giá trị dò tìm, dò vào 

trong bảng phụ dựa vào cột đầu tiên trong bảng 

phụ, nếu tìm thấy sẽ in ra ngay vị trí số thứ tự 

cột tham chiếu trong bảng phụ.

II. Các hàm thông dụng
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 6.1. Hàm VLOOKUP (dò tìm theo chiều dọc)

+ Cách dò : 

-Nếu cách dò là 0 : dò tìm chính xác . Có nghĩa là nếu 
không dò tìm thấy “giá trị dò tìm” trên cột đầu tiên của 
“bảng phụ” thì hàm sẽ báo lỗi (thông thường là báo lỗi 
#N/A! )

-Nếu cách dò là 1 : dò tìm tương đối. Có nghĩa là nếu 
không dò tìm thấy “giá trị dò tìm” trên cột đầu tiên của 
“bảng phụ” thì hàm sẽ lấy giá trị lớn hơn hoặc  gần 
bằng với nó nhất. Trong trường hợp đối số này là 1 thì 
ta có thể bỏ qua . 

II. Các hàm thông dụng
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6.2. Hàm HLOOKUP (dò tìm theo chiều ngang)

Cú Pháp : =HLOOKUP(giá trị dò tìm, bảng 
dò tìm, dòng tham chiếu, cách dò)

+ Giá trị dò tìm : là giá trị 1 ô kiểu số hoặc kiểu 
chuỗi trên bảng chính có liên quan đến bảng 
phụ (bảng dò tìm)

+ Bảng dò tìm (bảng phụ) : là địa chỉ của 1 khối 
dữ liệu  (khối này thường phải dùng địa chỉ cố 
định bằng cách sử dụng phím F4)

II. Các hàm thông dụng

102

6.2. Hàm HLOOKUP (dò tìm theo chiều ngang)

+ Dòng tham chiếu : số thứ tự dòng cần lấy 
trong bảng phụ tính từ trên xuống. 

+ Cách dò : chỉ mang một trong hai giá trị là 0
(tìm chính xác) hay 1 (tìm tương đối)

+ Ý nghĩa : Hàm này lấy giá trị dò tìm, dò vào 
trong bảng phụ dựa vào dòng đầu tiên trong 
bảng phụ, nếu tìm thấy sẽ in ra ngay vị trí số 
thứ tự dòng tham chiếu trong bảng phụ.

II. Các hàm thông dụng
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 Nếu dữ liệu cần lấy trong bảng phụ được sắp 

xếp theo dạng cột thì ta dùng VLOOKUP, 

 Nếu dữ liệu cần lấy trong bảng phụ được sắp 

xếp theo dạng dòng thì dùng HLOOKUP để 

lấy.

 Nếu giá trị dò tìm là chuỗi thì cách dò là 0, 

giá trị dò tìm là số hoặc ngày tháng thì cách 

dò là 1

Chú ý:
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II. Các hàm thông dụng

 Thực hành: Nhập vào dữ liệu sau
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II. Các hàm thông dụng

Mô tả:

- Tên đơn vị dựa vào mã đơn vị và tìm trong 

bảng DANH MỤC ĐƠN VỊ.

- Trợ cấp độc hại dựa vào mã đơn vị và tìm 

trong bảng Danh mục đơn vị.

- Lương = Hệ số lương * Mức lương

Trong đó mức lương được tính dựa theo mã 

đơn vị trong bảng danh mục đơn vị.

- Tổng lương = Trợ cấp độc hại + Lương.
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- HẾT -


